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12

Maintain the Node
This chapter provides procedures for maintaining the Cisco ONS 15454, including database backups and
restoration, removing and replacing cards, viewing the ONS 15454 audit trail, and hardware
maintenance procedures such as cleaning fibers, changing the fan tray filter, and other maintenance
procedures.

Note

Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454 SDH
Troubleshooting Guide as necessary for general troubleshooting information and alarm or error
descriptions.
This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).
1.

NTP-G103 Back Up the Database, page 12-2—Complete as needed.

2.

NTP-G104 Restore the Database, page 12-3—Complete as needed.

3.

NTP-G105 Restore the Node to Factory Configuration, page 12-4—Complete as needed to clear the
database and upload a blank database and the latest software.

4.

NTP-G106 Reset Cards Using CTC, page 12-9—Complete as needed to reset the Advanced Timing,
Communications, and Control (TCC2/TCC2P) and dense wavelength division multiplexing
(DWDM) cards.

5.

NTP-G108 Viewing the Audit Trail Records, page 12-11—Complete as needed.

6.

NTP-G109 Off-Load the Audit Trail Record, page 12-13—Complete as needed.

7.

NTP-G110 Off-Load the Diagnostics File, page 12-13—Complete as needed.

8.

NTP-G112 Change the Node Timing Reference, page 12-14—Complete as needed.

9.

NTP-G113 View the ONS 15454 Timing Report, page 12-16—Complete as needed.

10. NTP-G114 Inspect, Clean, and Replace the Air Filter, page 12-19—Complete as needed.
11. NTP-G115 Clean Fiber Connectors, page 12-22—Complete as needed.
12. NTP-G40 Replace the Front Door, page 12-25—Complete as needed.
13. NTP-G116 Replace the Fan-Tray Assembly, page 12-27—Complete as needed.
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14. NTP-G117 Replace the ANSI Shelf Alarm Interface Panel, page 12-32—Complete as needed.
15. NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover, page 12-36—Complete as

needed.
16. NTP-G135 Edit Network Element Defaults, page 12-38—Complete as needed to edit the

factory-configured (default) network element settings for the Cisco ONS 15454.
17. NTP-G136 Import Network Element Defaults, page 12-39—Complete as needed to import the

factory-configured (default) network element settings for the Cisco ONS 15454.
18. NTP-G137 Export Network Element Defaults, page 12-40—Complete as needed to export the

factory-configured (default) network element settings for the Cisco ONS 15454.

NTP-G103 Back Up the Database
Purpose

This procedure stores a backup version of the TCC2/TCC2P (software)
database on the workstation running Cisco Transport Controller (CTC)
or on a network server.

Tools/Equipment

None

Prerequisite Procedures

None

Required/As Needed

Required. Cisco recommends performing a database backup at
approximately weekly intervals and prior to and after configuration
changes.

Onsite/Remote

Onsite or remote

Security Level

Maintenance or higher

Note

You must back up and restore the database for each node on a circuit path in order to maintain a complete
circuit.

Note

The following parameters are not backed up and restored: node name, IP address, subnet mask and
gateway, and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a
backed up database with a different node name, the circuits map to the new node name. Cisco
recommends keeping a record of the old and new node names.

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node you want to back up. If you are
already logged in, continue with Step 2.

Step 2

Click the Maintenance > Database tabs.

Step 3

Click Backup.

Step 4

Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name
with the db file extension; for example, database.db.

Step 5

Click Save.

Step 6

Click OK in the confirmation dialog box.
Stop. You have completed this procedure.
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NTP-G104 Restore the Database

Note

Caution

Purpose

This procedure restores the TCC2/TCC2P card software database.

Tools/Equipment

None

Prerequisite Procedures

NTP-G103 Back Up the Database, page 12-2

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

The following parameters are not backed up and restored: node name, IP address, subnet mask and
gateway, and IIOP port. If you change the node name and then restore a backed up database with a
different node name, the circuits map to the new renamed node. Cisco recommends keeping a record of
the old and new node names.

If you are restoring the database on multiple nodes, wait approximately one minute after the
TCC2/TCC2P card reboot has completed on each node before proceeding to the next node.

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you are restoring the
database. If you are already logged in, continue with Step 2.

Step 2

Click the Circuits tab. Verify that no OCHNC circuits have a PARTIAL_OOS state. If so, investigate
and resolve the partial state before continuing.

Step 3

Complete the “DLP-G157 Disable Automatic Power Control” task on page 10-4.

Step 4

In node view, click the Maintenance > Database tabs.

Step 5

Click Restore.

Step 6

Locate the database file stored on the workstation hard drive or on network storage.
To clear all existing provisioning, locate and upload the database found on the latest ONS 15454
software CD.

Step 7

Click the database file to highlight it.

Step 8

Click OK. The DB Restore dialog box appears. Opening a restore file from another node or from an
earlier backup might affect traffic on the login node

Step 9

Click Yes.
The Restore Database dialog box monitors the file transfer (Figure 12-1).
Figure 12-1

Step 10

Restoring the Database—In-Process Notification

Wait for the file to complete the transfer to the TCC2/TCC2P card.
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Step 11

Click OK when the “Lost connection to node, changing to Network View” dialog box appears. Wait for
the node to reconnect.

Step 12

Complete the “DLP-G158 Enable Automatic Power Control” task on page 10-4.
Stop. You have completed this procedure.

NTP-G105 Restore the Node to Factory Configuration
Purpose

This procedure reinitializes the ONS 15454 using the CTC
reinitialization tool. Reinitialization uploads a new software package to
the TCC2/TCC2P cards, clears the node database, and restores the
factory default parameters.

Tools/Equipment

ONS 15454 System Software CD, Version 5.0
JRE 1.4.2 must be installed on the computer to log into the node at the
completion of the reinitialization. The reinitialization tool can run on
JRE 1.3.1_02 or JRE 1.4.2.

Prerequisite Procedures

NTP-G103 Back Up the Database, page 12-2
NTP-G17 Set Up Computer for CTC, page 2-1
One of the following:
•

NTP-G18 Set Up CTC Computer for Local Craft Connection to the
ONS 15454, page 2-9, or

•

NTP-G19 Set Up a CTC Computer for a Corporate LAN
Connection to the ONS 15454, page 2-21

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

Superuser

Caution

Cisco strongly recommends that you keep different node databases in separate folders. This is because
the reinit tool chooses the first product-specific software package in the specified directory if you use
the Search Path field instead of the Package and Database fields. You might accidentally copy an
incorrect database if multiple databases are kept in the specified directory.

Caution

Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution

Cisco recommends that you save the node database to safe location if you will not be restoring the node
using the database provided on the software CD.

Cisco ONS 15454 DWDM Installation and Operations Guide, R5.0

12-4

September 2005

Chapter 12

Maintain the Node
Before You Begin

Note

The following parameters are not backed up and restored when you delete the database and restore the
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node
name and then restore a backed up database with a different node name, the circuits map to the new
renamed node. Cisco recommends keeping a record of the old and new node names.

Step 1

If you need to install or replace one or more TCC2/TCC2P cards, see the “DLP-G33 Install the TCC2
or TCC2P Card” task on page 1-70.

Step 2

If you are using Microsoft Windows, complete the “DLP-G248 Use the Reinitialization Tool to Clear the
Database and Upload Software (Windows)” task on page 12-5.

Step 3

If you are using UNIX, complete the “DLP-G249 Use the Reinitialization Tool to Clear the Database
and Upload Software (UNIX)” task on page 12-7.
Stop. You have completed this procedure.

DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload
Software (Windows)
Purpose

This task reinitializes the ONS 15454 using the CTC reinitialization tool
on a Windows computer. Reinitialization uploads a new software
package to the TCC2/TCC2P cards, clears the node database, and
restores the factory default parameters.

Tools/Equipment

ONS 15454 System Software CD, Version 5.0
JRE 1.4.2 must be installed on the computer to log into the node at the
completion of the reinitialization. The reinitialization tool can run on
JRE 1.3.1_02 or JRE 1.4.2.

Prerequisite Procedures

NTP-G103 Back Up the Database, page 12-2
NTP-G17 Set Up Computer for CTC, page 2-1
One of the following:

Caution

•

NTP-G18 Set Up CTC Computer for Local Craft Connection to the
ONS 15454, page 2-9, or

•

NTP-G19 Set Up a CTC Computer for a Corporate LAN
Connection to the ONS 15454, page 2-21

Required/As Needed

As needed to clear the existing database from a TCC2/TCC2P and
restore the node default settings.

Onsite/Remote

Onsite

Security Level

Superuser

Restoring a node to the factory configuration deletes all cross-connects on the node.
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Note

Figure 12-2

The ONS 14545 Software CD is required if the Reinit.jar file, the CISCO 15454 package file,
and the NE default file are not stored on your computer.

Step 1

Insert the ONS 15454 System Software CD, Version 5.0, into the computer CD-ROM drive. If the CTC
Installation Wizard appears, click Cancel.

Step 2

From the Windows Start menu, choose Run. In the Run dialog box, click Browse and navigate to the
CISCO15454 or CISCO15454SDH folder on the software CD.

Step 3

In the Browse dialog box Files of Type field, choose All Files.

Step 4

Choose the RE-INIT.jar file and click Open. The NE Re-Initialization window appears (Figure 12-2).

Reinitialization Tool

Step 5

Complete the following fields:
•

GNE IP—If the node you are reinitializing is accessed through another node configured as a gateway
network element (GNE), enter the GNE IP address. If you have a direct connection to the node, leave
this field blank.

•

Node IP—Enter the node name or IP address of the node that you are reinitializing.

•

User ID—Enter the user ID needed to access the node.

•

Password—Enter the password for the user ID.

•

Upload Package—Check this box to send the software package file to the node. If unchecked, the
software stored on the node is not modified.

•

Force Upload—Check this box to send the software package file to the node even if the node is
running the same software version. If unchecked, reinitialization will not send the software package
if the node is already running the same version.

•

Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the
installed version) or revert to the uploaded software (if the software is earlier than the installed
version) as soon as the software file is uploaded. If unchecked, the software is not activated or
reverted after the upload, allowing you to initiate the functions later from the node view
Maintenance > Software tabs.

•

Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC
database restore operation.) If unchecked, the node database is not modified.

•

Confirm—Check this box if you want a warning message displayed before any operation is
performed. If unchecked, reinitialization does not display a warning message.
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•
Step 6

Caution

Step 7

Search Path—Enter the path to the CISCO15454 folder on the CD drive.

Click Go.

Before continuing with the next step, verify that the database to upload is correct. You cannot reverse
the upload process after you click Yes.
Review the information on the Confirm NE Re-Initialization dialog box, then click Yes to start the
reinitialization.
The reinitialization begins. After the software is downloaded and activated, and the database is uploaded
to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot.
Wait a few minutes for the reboot to complete.

Step 8

After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-24.

Step 9

Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8
and “NTP-G26 Set Up CTC Network Access” procedure on page 3-10.

Step 10

Return to your originating procedure (NTP).

DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload
Software (UNIX)
Purpose

This task reinitializes the ONS 15454 using the CTC reinitialization tool
on a UNIX computer. Reinitialization uploads a new software package
to the TCC2/TCC2P cards, clears the node database, and restores the
factory default parameters.

Tools/Equipment

ONS 15454 SONET System Software CD, Version 5.0.x
JRE 1.4.2 must be installed on the computer to log into the node at the
completion of the reinitialization. The reinitialization tool can run on
JRE 1.3.1_02 or JRE 1.4.2.

Prerequisite Procedures

NTP-G103 Back Up the Database, page 12-2
NTP-G17 Set Up Computer for CTC, page 2-1
One of the following:

Caution

•

NTP-G18 Set Up CTC Computer for Local Craft Connection to the
ONS 15454, page 2-9, or

•

NTP-G19 Set Up a CTC Computer for a Corporate LAN
Connection to the ONS 15454, page 2-21

Required/As Needed

As needed to clear the existing database from a TCC2/TCC2P and
restore the node default settings.

Onsite/Remote

Onsite

Security Level

Superuser

Restoring a node to the factory configuration deletes all cross-connects on the node.
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Step 1

Insert the system software CD containing the reinit tool, software, and defaults database into the
computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2

To find the recovery tool file, go to the CISCO15454 directory on the CD (usually
/cdrom/cdrom0/CISCO15454 or /cdrom/cdrom0/CISCO15454SDH).

Step 3

If you are using a file explorer, double-click the RE-INIT.jar file. If you are working with a command
line, run java -jar RE-INIT.jar. The NE Re-Initialization window appears (Figure 12-2).

Step 4

Complete the following fields:

Step 5

Caution

Step 6

•

GNE IP—If the node you are reinitializing is accessed through another node configured as a gateway
network element (GNE), enter the GNE IP address. If you have a direct connection to the node, leave
this field blank.

•

Node IP—Enter the node name or IP address of the node that you are reinitializing.

•

User ID—Enter the user ID needed to access the node.

•

Password—Enter the password for the user ID.

•

Upload Package—Check this box to send the software package file to the node. If unchecked, the
software stored on the node is not modified.

•

Force Upload—Check this box to send the software package file to the node even if the node is
running the same software version. If unchecked, reinitialization will not send the software package
if the node is already running the same version.

•

Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the
installed version) or revert to the uploaded software (if the software is earlier than the installed
version) as soon as the software file is uploaded. If unchecked, the software is not activated or
reverted after the upload, allowing you to initiate the functions later from the node view
Maintenance > Software tabs.

•

Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC
database restore operation.) If unchecked, the node database is not modified.

•

Confirm—Check this box if you want a warning message displayed before any operation is
performed. If unchecked, reinitialization does not display a warning message.

•

Search Path—Enter the path to the CISCO15454 or CISCO15454SDH folder on the CD drive.

Click Go.

Before continuing with the next step, verify that the database to upload is correct. You cannot reverse
the upload process after you click Yes.
Review the information on the Confirm NE Re-Initialization dialog box, then click Yes to start the
reinitialization.
The reinitialization begins. After the software is downloaded and activated and the database is uploaded
to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot.
Wait a few minutes for the reboot to complete.

Step 7

After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-24.

Step 8

Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-8
and “NTP-G26 Set Up CTC Network Access” procedure on page 3-10.

Step 9

Return to your originating procedure (NTP).
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NTP-G106 Reset Cards Using CTC
Purpose

This procedure resets the TCC2/TCC2P and DWDM cards using CTC.

Tools/Equipment

None

Prerequisite Procedures

DLP-G33 Install the TCC2 or TCC2P Card, page 1-70

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you are performing the
TCC2/TCC2P reset. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 12-9.

Step 3

As needed, complete the “DLP-G251 Reset DWDM Cards Using CTC” task on page 12-10.
Stop. You have completed this procedure.

DLP-G250 Reset the TCC2/TCC2P Card
Purpose

This task resets the TCC2/TCC2P card and switches the node to the
redundant TCC2/TCC2P.

Tools/Equipment

None

Prerequisite Procedures

DLP-G33 Install the TCC2 or TCC2P Card, page 1-70
DLP-G46 Log into CTC, page 2-24

Warning

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Note

Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change
you made to avoid losing any changes to the database.

Note

When a software reset is performed on an active TCC2/TCC2P, the AIC-I card goes through an
initialization process and also resets. The AIC-I card reset is normal and happens each time an active
TCC2/TCC2P card goes through a software-initiated reset.
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Step 1

Click the Alarms tab.
a.

Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 8-27
as necessary.

b.

Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve
them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide or
Cisco ONS 15454 SDH Troubleshooting Guide for procedures.

Step 2

In node view, right-click the TCC2/TCC2P card to reveal a drop-down list.

Step 3

Click Reset Card.

Step 4

Click Yes when the confirmation dialog box appears.

Step 5

Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note

For LED behavior during a TCC2/TCC2P reboot, see Table 3-2 on page 3-13.

Step 6

Confirm that the TCC2/TCC2P card LED is amber (standby).

Step 7

Return to your originating procedure (NTP).

DLP-G251 Reset DWDM Cards Using CTC
Purpose

This task resets the OSCM, OSC-CSM, 32MUX-O, 32DMX-O,
32DMX, 32WSS, OPT-BST, OPT-PRE, AD-xC.xx.x, AD-xB.xx.x,
TXP, and MXP cards using CTC.

Tools/Equipment

None

Prerequisite Procedures

NTP-G30 Install the DWDM Cards, page 3-27
NTP-G32 Install the Transponder and Muxponder Cards, page 3-31
DLP-G46 Log into CTC, page 2-24

Warning

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Note

ONS 15454 cards normally do not need to be reset. However, you may occasionally need to reset a card
for testing or as an initial trouble-clearing step. For additional information, see the Cisco ONS 15454
Troubleshooting Guide or Cisco ONS 15454 SDH Troubleshooting Guide.

Step 1

If you will switch an active TXP or MXP card that is in a Y-Cable protection group, complete the
“DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-25. If not, continue
with Step 2.
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Step 2

Right-click the card you want to reset to reveal a drop-down list.

Step 3

Click Reset Card.

Step 4

Click Yes when the confirmation dialog box appears.
The card LED on the ONS 15454 shelf graphic will go through the following sequence: Fail (white
LED), Ldg (white LED), and Act (green LED). The reset should complete within 1 to 2 minutes.

Step 5

If you performed a Y-Cable protection group switch in Step 1, complete the “DLP-G180 Clear a Manual
or Force Y-Cable or Splitter Protection Switch” task on page 10-26. If not, continue with Step 6.

Step 6

Return to your originating procedure (NTP).

NTP-G108 Viewing the Audit Trail Records
Purpose

This procedure explains how to view audit trail records. Audit trail records
are useful for maintaining security, recovering lost transactions, and
enforcing accountability. Accountability refers to tracing user activities;
that is, associating a process or action with a specific user.

Tools/Equipment

None

Prerequisite Procedures None
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to view the audit
trail log. If you are already logged in, continue with Step 2.

Step 2

In the node view, click the Maintenance > Audit tabs.

Step 3

Click Retrieve.
A window containing the most recent audit trail records appears as shown in Figure 12-3.
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Figure 12-3

Viewing the Audit Trail Records

A definition of each column in the audit trail log is listed in Table 12-1.
Table 12-1

Audit Trail Column Definitions

Column

Definition

Date

Date when the action occurred in the format MM/dd/yy HH:mm:ss

Num

Incrementing count of actions

User

User ID that initiated the action

P/F

Pass/Fail (that is, whether or not the action was executed)

Operation

Action that was taken

Right-click on the column headings to display the list in ascending-to-descending or
descending-to-ascending order.
Left-click on the column heading to display the following options:
•

Reset Sorting—Resets the column to the default setting

•

Hide Column—Hides the column from view

•

Reset Columns Order/Visibility—Displays all hidden columns

•

Row Count—Provides a numerical count of log entries

Shift-click on the column heading for an incremental sort of the list.
Stop. You have completed this procedure.
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NTP-G109 Off-Load the Audit Trail Record
Purpose

This procedure describes how to off-load up to 640 audit trail log entries
in a local or network drive file to maintain a record of actions performed
for the node. If the audit trail log is not off-loaded, the oldest entries are
overwritten after the log reaches capacity.

Tools/Equipment

None

Prerequisite Procedures

None

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to off-load the
audit trail log. If you are already logged in, continue with Step 2.

Step 2

In the node view, click the Maintenance > Audit tabs.

Step 3

Click Retrieve.

Step 4

Click Archive.

Step 5

In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to
save the file.

Step 6

Enter a name in the File Name field.
You do not have to give the archive file a particular extension. It is readable in any application that
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7

Click Save. Click OK
The 640 entries are saved in this file. The next entries continue with the next number in the sequence,
rather than starting over.

Note

Archiving does not delete entries from the CTC audit trail log. However, entries can be
self-deleted by the system after the log maximum is reached. If you archived the entries, you
cannot reimport the log file back into CTC and will have to view the log in a different
application.

Stop. You have completed this procedure.

NTP-G110 Off-Load the Diagnostics File
Purpose

This procedure describes how to off-load a diagnostic file. The diagnostic
file contains a set of debug commnds run on a node and its results. This
file is useful to TAC when troubleshooting problems with the node.

Tools/Equipment

None

Prerequisite Procedures

None
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Purpose

This procedure describes how to off-load a diagnostic file. The diagnostic
file contains a set of debug commnds run on a node and its results. This
file is useful to TAC when troubleshooting problems with the node.

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Maintenance or higher

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to off-load the
diagnostics file. If you are already logged in, continue with Step 2.

Step 2

In the node view, click the Maintenance > Diagnostic tabs.

Step 3

Click Retrieve Tech Support Log.

Step 4

In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to
save the file.

Step 5

Enter a name in the File Name field.
You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be
unzipped and read by Cisco Technical Support.

Step 6

Click Save.
The Get Diagnostics status window shows a progress bar indicating the percentage of the file being
saved, then shows “Get Diagnostics Complete.”

Step 7

Click OK.
Stop. You have completed this procedure.

NTP-G112 Change the Node Timing Reference
Purpose

This procedure enables automatic timing reference switching or returns
the node timing to normal operation.

Tools/Equipment

None

Prerequisite Procedures

NTP-G53 Set Up Timing, page 6-3

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Maintenance or higher

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to enable timing
switching. If you are already logged in, continue with Step 2.

Step 2

Complete the “DLP-G259 Manual or Force Switch the Node Timing Reference” task on page 12-15 as
needed.

Step 3

Complete the “DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference” task on
page 12-15 as needed.
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Stop. You have completed this procedure.

DLP-G259 Manual or Force Switch the Node Timing Reference
Purpose

This task commands the node to switch to the timing reference you have
selected.

Tools/Equipment

None

Prerequisite Procedures

DLP-G46 Log into CTC, page 2-24

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Maintenance or higher

Step 1

In node view, click the Maintenance > Timing > Source tabs.

Step 2

From the Reference drop-down list for the desired Clock, choose the desired reference.

Step 3

From the Operation drop-down list for the desired Clock, choose one of the following options:
•

Manual—This operation commands the node to switch to the reference you have selected if the
SSM quality of the reference is not lower than the current timing reference.

•

Force—This operation commands the node to switch to the reference you have selected, regardless
of the SSM quality (if the reference is valid).

Note

For information about the Clear option, see the “DLP-G260 Clear a Manual or Force Switch
on a Node Timing Reference” task on page 12-15.

Step 4

Click Apply next to the timing source.

Step 5

Click Yes in the confirmation dialog box. If the selected timing reference is an acceptable valid
reference, the node switches to the selected timing reference. If the selected timing reference is invalid,
a warning dialog box appears. Click OK; the node will not switch to the new timing reference.

Step 6

Return to your originating procedure (NTP).

DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference
Purpose

This task clears a Manual or Force switch on a node timing reference and
reverts the timing reference to its provisioned reference.

Tools/Equipment

None

Prerequisite Procedures

DLP-G46 Log into CTC, page 2-24

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Maintenance or higher
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Step 1

In node view, click the Maintenance > Timing > Source tabs.

Step 2

Find the Clock reference that is currently set to Manual or Force in the Operation menu.

Step 3

From the Operation drop-down list, choose Clear.

Step 4

Click Apply.

Step 5

Click Yes in the confirmation dialog box. If the normal timing reference is an acceptable valid reference,
the node switches back to the normal timing reference as defined by the system configuration. If the
normal timing reference is invalid or has failed, a warning dialog box appears. Click OK; the timing
reference will not revert.

Step 6

Return to your originating procedure (NTP).

NTP-G113 View the ONS 15454 Timing Report

Table 12-2

Purpose

This procedure displays the current status of the ONS 15454 timing
references.

Tools/Equipment

None

Prerequisite Procedures

NTP-G53 Set Up Timing, page 6-3

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Maintenance or higher

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to view the node
timing status. If you are already logged in, continue with Step 2.

Step 2

Click the Maintenance > Timing > Report tabs.

Step 3

In the Timing Report area, you can view node timing information. The date and time of the report appear
at the top of the report. The time stamp is the same as the alarms time stamp and can be configured using
the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 8-10. Table 12-2
describes the report fields and entries.

Step 4

To update the report, click Refresh.

ONS 15454 Timing Report

Item

Description

Option

Clock

NE
Indicates the
timing clock. The BITS-1 Out
report section that
follows applies to BITS-2 Out
the timing clock
indicated.

Option Description
The node timing clock.
The BITS-1 Out timing clock.
The BITS-2 Out timing clock.
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Table 12-2

ONS 15454 Timing Report (continued)

Item

Description

Option

Option Description

Status

Indicates the
status of the
timing clock.

INIT_STATE

The timing reference has not been provisioned. For an NE
reference, this status appears just before the first
provisioning messages when the TCC2/TCC2P card is
booting. Timing is provisioned to the internal clock of the
node.

HOLDOVER_STATE

The clock was locked onto a valid timing reference for
more than 140 seconds when a failure occurred. Holdover
state timing is a computation based on timing during
normal state combined with the node’s internal clock. The
node holds onto this frequency until the valid reference is
restored. This status appears for NE references only.

FREERUN_STATE

The node is running off its internal clock without any
modification except the calibrated value to bring timing to
0 PPM. Freerun state can occur when a Force switch to the
Internal clock is initiated, when all references fail without
the 140 seconds of holdover data, or when only Internal
timing references are defined. This status appears for NE
references only.

NO_SYNC_STATE

A synchronization timing reference is not defined.
BITS-1 Out or BITS-2 Out default to this status until an
OC-N card is defined as its reference on the
Provisioning > Timing tab. This status appears for external
references only.

NE_SYNCH_STATE

BITS-1 Out and BITS-2 Out use the same timing source as
the NE. This is displayed when NE Reference is selected
in the BITS-1 Out and BITS-2 Out Reference List on the
Provisioning > Timing tab.

NORMAL_STATE

The timing reference is locked onto one of its provisioned
references. The reference cannot be Internal or
NO SYNC STATE.

FAST_START_STATE

The node has switched references, but the reference is too
far away to reach NORMAL_STATE within an acceptable
amount of time. FAST_START_STATE is a fast
acquisition mode to allow the node to quickly acquire the
reference. After it achieves this goal, the node progresses
to the normal state.

FAST_START_FAILED_STATE A timing reference is too far away to reach in normal state.
The FAST_START_STATE could not acquire sufficient
timing information within the allowable amount of time.
Status
Changed
At

Date and time of
the last status
change.

—

—

Switch
Type

Type of switch.

AUTOMATIC

The timing switch was system-generated.

Manual

The timing switch was a user-initiated Manual switch.

Force

The timing switch was user-initiated Force switch.
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Table 12-2

Item

ONS 15454 Timing Report (continued)

Description

Option

Option Description

Reference Indicates the
timing reference.

Three timing references are
available on the Provisioning >
Timing tab.

—

Selected

Indicates whether
the reference is
selected.

Selected references are indicated —
with an X.

Facility

BITS-1
Indicates the
timing facility
provisioned for
BITS-2
the reference on
the Provisioning >
OC-N/STM-N card with port
Timing tab.
number

The timing facility is a building integrated timing supply
(BITS) clock attached to the node’s BITS-1 pins.
The timing facility is a BITS clock attached to the node’s
BITS-2 pins.
If the node is set to line timing, this is the OC-N /STM-N
card and port provisioned as the timing reference.

Internal clock

The node is using its internal clock.

IS

The timing reference is in service.

OOS

The timing reference is out of service.

Condition Indicates the
timing reference
state.

OKAY

The reference is valid to use as a timing reference.

OOB

Out of bounds; the reference is not valid and cannot be
used as a timing reference, for example, a BITS clock is
disconnected.

Condition Indicates the date
Changed and time of the
last status change
in MM/DD/YY
HH:MM:SS
format.

—

—

SSM

Enabled

SSM is enabled.

Disabled

SSM is not enabled.

State

Indicates the
timing reference
state.

Indicates whether
SSM is enabled
for the timing
reference.

SSM
Quality

Indicates the SSM 8 to 10 SSM quality messages
timing quality.
might be displayed.

SSM
Changed

Indicates the date
and time of the
last SSM status
change in
MM/DD/YY
HH:MM:SS
format.

—

For a list of SSM message sets, see the
“19.2.2 Synchronization Status Messaging” section on
page 19-8.
—

Stop. You have completed this procedure.
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NTP-G114 Inspect, Clean, and Replace the Air Filter

Warning

Caution

Note

Purpose

This procedure ensures that the air filter is free from dirt and dust, which
allows optimum air flow and prevents dirt and dust from entering the
shelf.

Tools/Equipment

Vacuum or detergent and water faucet, spare filter, pinned hex key tool

Prerequisite Procedures

None

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

None

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Cisco recommends that you inspect the air filter monthly, and clean the filter every three to six months.
Replace the air filter every two to three years. Avoid cleaning the air filter with harsh cleaning agents or
solvents.

Although the filter can work if it is installed with either side facing up, Cisco recommends that you
install it with the metal bracing facing up to preserve the surface of the filter.

Step 1

Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell,
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later
versions of the ONS 15454 use a reusable air filter.

Step 2

If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being
careful not to dislodge any dust that might have collected on the filter and proceed to Step 9. Figure 12-4
shows the reusable fan-tray air filter in an external filter bracket on an ANSI shelf. Figure 12-5 shows
the reusable fan-tray air filter in an external filter bracket on an ETSI shelf.

Step 3

If the filter is installed below the fan tray and not in the external filter brackets, open the front door of
the shelf assembly. If the front door is already open, proceed to Step 4.
a.

Open the front door lock.
The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key
counterclockwise to unlock the door and clockwise to lock it.

Step 4

b.

Press the door button to release the latch.

c.

Swing the door open.

Remove the front door (optional). If you do not want to remove the door or it is already removed, proceed
to Step 5.
a.

Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b.

Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c.

Secure the dangling end of the ground strap to the door or chassis with tape.
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ANSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

FAN

34237

Figure 12-4

FAIL
CR

IT
MAJ
MIN

Fan tray filter

ETSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

61235

Figure 12-5

Fan tray filter
Step 5

Push the outer side of the handles on the fan-tray assembly to expose the handles.
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Step 6

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

Step 7

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 8

Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that might have
collected on the filter.

Step 9

Visually inspect the air filter material for dirt and dust.

Step 10

If the reusable air filter contains a concentration of dirt and dust, replace the dirty air filter with a clean
air filter (spare filters should be kept in stock) and reinsert the fan-tray assembly. Then, vacuum the dirty
air filter or wash it under a faucet with a light detergent.

Caution

Do not leave the fan tray out of the chassis for an extended period of time because excessive heat can
damage the ONS 15454 cards.

Note

Step 11

Caution
Step 12

Caution

Cleaning should take place outside of the operating environment to avoid releasing dirt and dust
near the equipment.

If you washed the filter, allow it to completely air dry for at least eight hours.

Do not put a damp filter back in the ONS 15454.
Replace the clean filter:
a.

If the air filter is installed in the external filter brackets, slide the dry air filter all the way to the back
of the brackets to complete the procedure, continue to step 16.

b.

If the filter is installed below the fan-tray assembly, remove the fan-tray assembly and slide the
dry/clean air filter into the recessed compartment at the bottom of the shelf assembly. Put the front
edge of the air filter flush against the front edge of the recessed compartment. Push the fan tray back
into the shelf assembly.

If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and
readjust the position of the reusable filter until the fan tray fits correctly.

Note

On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly
inserted.

Step 13

To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray
assembly is activated and displays node information.

Step 14

Rotate the retractable handles back into their compartments.

Step 15

If you replace the door, also reattach the ground strap.

Step 16

Close and lock the door.
Stop. You have completed this procedure.
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NTP-G115 Clean Fiber Connectors
Purpose

This procedure cleans the fiber connectors.

Tools/Equipment

Inspection microscope
Compressed air/duster
Type A Fiber Optic Connector Cleaner (CLETOP reel)
Isopropyl alcohol 70 percent or higher
Optical swab
Optical receiver cleaning stick

Warning

Prerequisite Procedures

None

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

None

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Step 1

Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2

Replace any damaged fiber connectors.

Note

Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3

Complete the “DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry
Wipes” task on page 12-23 as necessary.

Step 4

Complete the “DLP-G262 Clean Fiber Connectors with CLETOP” task on page 12-23 as necessary.

Step 5

Complete the “DLP-G263 Clean the Fiber Adapters” task on page 12-24 as necessary.
Stop. You have completed this procedure.
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DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and
Dry Wipes
Purpose

This task cleans the fiber connectors and adapters with alcohol and dry
wipes.

Tools/Equipment

Compressed air/duster
Isopropyl alcohol 70 percent or higher
Optical swab
Optical receiver cleaning stick

Warning

Prerequisite Procedures

None

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

None

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Step 1

Remove the dust cap from the fiber connector.

Step 2

Wipe the connector tip with the premoistened alcohol wipe.

Step 3

Blow-dry using filtered air.

Step 4

Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the
connector is not clean, repeat Steps 1 to 3.

Step 5

Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.
If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the dust
cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap using a CLETOP
stick swab (14100400).

Step 6

Return to your originating procedure (NTP).

DLP-G262 Clean Fiber Connectors with CLETOP
Purpose

This task cleans the fiber connectors with CLETOP.

Tools/Equipment

Type A Fiber Optic Connector Cleaner (CLETOP reel)
Optical receiver cleaning stick

Prerequisite Procedures

None

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

None
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Step 1

Remove the dust cap from the fiber connector.

Step 2

Press the lever down to open the shutter door. Each time you press the lever, you expose a clean wiping
surface.

Step 3

Insert the connector into the CLETOP cleaning cassette slot, rotate one quarter turn, and gently swipe
downwards.

Step 4

Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the
connector is not clean, repeat Steps 1 to 3.

Step 5

Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note

Step 6

If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the
dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap
using a CLETOP stick swab (14100400).

Return to your originating procedure (NTP).

DLP-G263 Clean the Fiber Adapters
Purpose

This task cleans the fiber adapters.

Tools/Equipment

CLETOP stick swab

Prerequisite Procedures

None

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

None

Step 1

Remove the dust plug from the fiber adapter.

Step 2

Insert a CLETOP stick swab (14100400) into the adapter opening and rotate the swab.

Step 3

Place dust plugs on the fiber adapters when not in use.

Step 4

Return to your originating procedure (NTP).
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NTP-G40 Replace the Front Door
Purpose

This procedure replaces the front door and door ground strap after
installing cards and fiber-optic cables.

Tools/Equipment

#2 Phillips screwdriver
Medium slot-head screwdriver
Small slot-head screwdriver

Prerequisite Procedures NTP-G3 Open and Remove the Front Door, page 1-20

Note

Required/As Needed

Required

Onsite/Remote

Onsite

Security Level

None

Be careful not to crimp any fiber cables that are connected to the MXP/TXP cards or DWDM cards.
Some might not have the fiber boot attached.

Step 1

Insert the front door into the hinges on the shelf assembly.

Step 2

Attach one end of the ground strap terminal lug (72-3622-01) to the male stud on the inside of the door.
Attach and tighten the #6 Kepnut (49-0600-01) using the open-end wrench (Figure 12-6).
Installing the Door Ground Strap Retrofit Kit

71048

Figure 12-6

Step 3

Attach the other end of the ground strap to the longer screw on the fiber guide.
a.

Attach the lock washer.
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b.

Attach the terminal lug.

c.

Using the open-end wrench, attach and tighten the #4 Kepnut (49-0337-01) on the terminal lug.

Note

To avoid interference with the traffic (line) card, make sure the ground strap is in a flat
position when the door is open. To move the ground strap into a flat position, rotate the
terminal lug counterclockwise before tightening the Kepnut.

Step 4

Replace the left cable-routing channel.

Step 5

Using a Phillips screwdriver, insert and tighten the screws for the cable-routing channel.
Figure 12-7 shows the shelf assembly with the front door and ground strap installed.
Shelf Assembly with Door Ground Strap Retrofit Kit Installed

71046

Figure 12-7

Ground strap cable
Step 6

Swing the door closed.

Note

The ONS 15454 comes with a pinned hex key tool for locking and unlocking the front door. Turn
the key counterclockwise to unlock the door and clockwise to lock it.

Stop. You have completed this procedure.
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NTP-G116 Replace the Fan-Tray Assembly
Purpose

This procedure replaces a malfunctioning fan-tray assembly.

Tools/Equipment

None

Prerequisite Procedures

NTP-G8 Install the Fan-Tray Assembly

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

None

Caution

The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). The fan-tray assembly includes a
pin that prevents it from being installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution

Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or
the connectors on the backplane.

Note

Step 1

To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities.
Review Table 12-3 (ANSI) or Table 12-4 (ETSI) to ensure that you have compatible components when
replacing the fan-tray assembly. Note the alarms that will be generated when an incompatibility occurs.

Note

If you need to determine the hardware that has been installed on a node, click the Inventory tab
in node view.

Table 12-3

Incompatibility Alarms for ONS 15454 ANSI

Shelf Assembly1

Fan Tray2

AIP3

10G Cards4

Ethernet Cards5

Alarms

—

—

No fuse

—

—

Mismatch of
Equipment Attributes
(MEA) on alarm
interface panel (AIP)

NEBS3E or NEBS3

2A

2A

No

—

None

NEBS3E or NEBS3

2A

2A

Yes

—

MEA on 10G

NEBS3E or NEBS3

2A

5A

No

—

None

NEBS3E or NEBS3

2A

5A

Yes

—

MEA on 10G

ANSI or HD

2A

2A

No

—

None

ANSI or HD

2A

2A

Yes

2.5G compatible

MEA on fan tray, AIP,
and Ethernet
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Table 12-3

Incompatibility Alarms for ONS 15454 ANSI (continued)

Shelf Assembly1

Fan Tray2

AIP3

10G Cards4

Ethernet Cards5

Alarms

ANSI or HD

2A

2A

Yes

10G compatible

MEA on fan tray and
AIP

ANSI or HD

2A

5A

No

Either

None

ANSI or HD

2A

5A

Yes

2.5G compatible

MEA on fan tray and
Ethernet

ANSI or HD

2A

5A

Yes

10G compatible

MEA on fan tray

ANSI or HD

5A

2A

No

Either

MEA on AIP

ANSI or HD

5A

2A

Yes

2.5G compatible

MEA on AIP and
Ethernet

ANSI or HD

5A

2A

Yes

10G compatible

MEA on AIP

ANSI or HD

5A

5A

No

Either

None

ANSI or HD

5A

5A

Yes

Either

None

1. 15454-SA-NEBS3E (P/N: 800-07149-xx) or 15454-SA-NEBS3 (P/N: 800-06741-xx) = shelf assemblies released before
ONS 15454 Release 3.1
15454-SA-ANSI (P/N: 800-19857-01) = ONS 15454 Release 3.1 and later shelf assembly
15454-SA-HD (P/N: 800-24848) = ONS 15454 Release 3.1 and later shelf assembly
2. 5A Fan Tray = 15454-FTA3 (P/N: 800-19858-xx) or 15454-FTA3-T (P/N: 800-21448-xx)
2A Fan Tray = 15454-FTA2 (P/Ns: 800-07145-xx, 800-07385-xx, 800-19591-xx, 800-19590-xx)
3. 5A AIP (P/N: 73-7665-01), 2A AIP (P/N: 73-5262-01)
4. 10G cards include the XC10G, OC192, and OC48AS.
5. 2.5G indicates cards that are compatible with the XCVT cross-connect card. 10G indicates cards that are compatible with the
XC10G and XC-VXC-10G cross-connect cards.

Table 12-4

Incompatibility Alarms for ONS 15454 ETSI

Shelf Assembly 1

Fan Tray2

10G Cards3

Ethernet Cards

Alarms

15454E-SA-ETSI

2A

No

—

None

15454E-SA-ETSI

2A

Yes

—

MEA on 10G

15454E-SA-ETSI

2A

No

—

None

15454E-SA-ETSI

2A

Yes

—

MEA on 10G

15454E-SA-ETSI

5A

No

—

MEA on fan tray

15454E-SA-ETSI

5A

Yes

—

MEA on fan tray and 10G
cards

15454E-SA-ETSI

5A

No

—

None

15454E-SA-ETSI

5A

Yes

—

MEA on 10G

ETSI

2A

No

—

None

ETSI

2A

Yes

2.5G compatible

MEA on fan tray or
Ethernet

ETSI

2A

Yes

10G compatible

MEA on fan tray

ETSI

2A

No

Either

None

ETSI

2A

Yes

2.5G compatible

MEA on fan tray, Ethernet
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Table 12-4

Incompatibility Alarms for ONS 15454 ETSI (continued)

Shelf Assembly 1

Fan Tray2

10G Cards3

Ethernet Cards

Alarms

ETSI

2A

Yes

10G compatible

MEA on fan tray

ETSI

5A

Yes

2.5G compatible

MEA on Ethernet

ETSI

5A

No

Either

None

ETSI

5A

Yes

Either

None

1. 15454-SA-ETSI (P/N: 800-08708-XX) = ONS 15454 SDH Release 3.3 and later shelf assembly
2. 5A Fan Tray = 15454E-FTA-60V
2A Fan Tray = 15454E-FTA-48V
3. 10G cards = XC-10G, XC-VXL-10G, XC-VXC-10G

Step 2

Open the front door of the shelf assembly. If the shelf assembly does not have a front door, continue with
Step 4.
a.

Open the front door lock.
The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key
counterclockwise to unlock the door and clockwise to lock it.

Step 3

b.

Press the door button to release the latch.

c.

Swing the door open.

Remove the front door (optional). If you do not want to remove the door, proceed to Step 4.
a.

Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b.

Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c.

Secure the dangling end of the ground strap to the door or chassis with tape.

Step 4

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Step 5

Fold out the retractable handles at the outside edges of the fan tray.

Step 6

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

Step 7

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.
Figure 12-8 shows the location of the fan tray on the ONS 15454 ANSI shelf.
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Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ANSI)

38532

Figure 12-8
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Figure 12-9 shows the location of the fan tray on the ONS 15454 ETSI shelf.
Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ETSI)

61236

Figure 12-9
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Step 8

Fan tray
assembly

If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.
If you are replacing the fan-tray air filter and it is installed in the external bottom bracket (ANSI shelf
only), you can slide the existing air filter out of the bracket and replace it at anytime. For more
information on the fan-tray air filter, see the “NTP-G114 Inspect, Clean, and Replace the Air Filter”
procedure on page 12-19.

Step 9

Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into
the corresponding receptacle on the backplane.

Step 10

To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is
activated.

Step 11

If you replace the door on an ANSI shelf, be sure to reattach the ground strap.
Stop. You have completed this procedure.
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NTP-G117 Replace the ANSI Shelf Alarm Interface Panel
Purpose

This procedure replaces the alarm interface panel (AIP) on the
ONS 15454 ANSI shelf assembly.

Tools/Equipment

#2 Phillips screwdriver

Prerequisite Procedures

None

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Caution

Do not use a 2A AIP with a 5A fan-tray assembly; doing so will cause a blown fuse on the AIP.

Caution

Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Caution

Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and
result in a loss of data. For assistance with AIP replacement, contact the Cisco Technical Assistance
Center. See the “Obtaining Technical Assistance” section on page lxxiv.

Step 1

Review Table 12-3 on page 12-27 to ensure that you have compatible components when replacing the
fan-tray assembly and note the alarms that will occur when an incompatibility occurs.

Step 2

Ensure that all nodes in the affected network are running the same software version before replacing the
AIP and repairing circuits:

Step 3

a.

In network view, click the Maintenance > Software tabs. The working software version for each
node is listed in the Working Version column.

b.

If you need to upgrade the software on a node, refer to the release-specific software upgrade
document. No hardware should be changed or circuit repair performed until after the software
upgrade is complete. If you do not need to upgrade software or have completed the software
upgrade, proceed to Step 3.

Record the MAC address of the old AIP:
a.

Log into the node where you will replace the AIP. See the “DLP-G46 Log into CTC” task on
page 2-24.

b.

In node view, click the Provisioning > Network tabs.

c.

Record the MAC address shown in the General tab (Figure 12-10).
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Figure 12-10

Find the MAC Address

Step 4

Call Cisco TAC for assistance in replacing the AIP and maintaining the original MAC address. See the
“Obtaining Technical Assistance” section on page lxxiv.

Step 5

Unscrew the five screws that hold the lower backplane cover in place (Figure 12-11).
Lower Backplane Cover

32069

Figure 12-11

Retaining
screws
Step 6

Grip the lower backplane cover and gently pull it away from the backplane.

Step 7

Unscrew the two screws that hold the AIP cover in place.

Step 8

Grip the cover and gently pull away from the backplane.

Note

On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.
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Step 9

Grip the AIP and gently pull it away from the backplane.

Step 10

Disconnect the fan-tray assembly power cable from the AIP.

Step 11

Set the old AIP aside for return to Cisco.

Caution

The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP,
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149)
shelves and earlier use the 2A AIP (P/N: 73-5262-01).

Caution

Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD
(P/N: 800-24848) shelf; doing so will cause a blown fuse on the AIP.

Step 12

Attach the fan-tray assembly power cable to the new AIP.

Step 13

Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 14

Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 15

Replace the lower backplane cover and secure the cover with the five screws.

Step 16

In node view, click the Provisioning > Network tabs.

Caution

Step 17

Cisco recommends that TCC2/TCC2P card resets be performed in a maintenance window to avoid any
potential service disruptions.
Reset the standby TCC2/TCC2P card:
a.

Right-click the standby TCC2/TCC2P card and choose Reset Card.

b.

Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears
on the card in CTC.

Note

The reset takes approximately five minutes. Do not perform any other steps until the reset is
complete.

Step 18

Complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 12-9 to reset the active
TCC2/TCC2P card.

Step 19

From the File drop-down list, choose Exit to exit the CTC session.

Step 20

Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down
list.

Step 21

Record the new MAC address:
a.

In node view, click the Provisioning > Network tabs.

b.

Record the MAC address shown in the General tab.

Step 22

In node view, click the Circuits tab. Note that all circuits listed have a status of PARTIAL.

Step 23

In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box
appears.
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Step 24

Read the instructions in the Circuit Repair dialog box (Figure 12-12). If all the steps in the dialog box
have been completed, click Next. Ensure that you have the old and new MAC addresses.
Figure 12-12

Step 25

The Node MAC Addresses dialog box appears (Figure 12-13):
a.

From the Node drop-down list, choose the name of the node where you replaced the AIP.

b.

In the Old MAC Address field, enter the old MAC address that was recorded in Step 3.

c.

Click Next.

Figure 12-13

Step 26

Repairing Circuits

Recording the Old MAC Address Before Replacing the AIP

The Repair Circuits dialog box appears (Figure 12-14). Read the information in the dialog box and click
Finish.
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Figure 12-14

Note

Circuit Repair Information

The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes
or more depending on the number of circuits provisioned.

When the circuit repair is complete, the Circuits Repaired dialog box appears.
Step 27

Click OK.

Step 28

In the node view of the new node, click the Circuits tab. Check to ensure that all circuits listed have a
status of DISCOVERED. If all circuits listed are not DISCOVERED, call the Cisco TAC at
(800) 553-2447 to open a Return Material Authorization (RMA).
Stop. You have completed this procedure.

NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane
Cover
Purpose

This procedure replaces the plastic cover located at the bottom rear of
the ONS 15454 ANSI shelf.

Tools/Equipment

Phillips screwdriver

Prerequisite Procedures

None

Required/As Needed

As needed

Onsite/Remote

Onsite

Security Level

None

Step 1

Use the Phillips screwdriver to unscrew the five retaining screws that hold the metal cover in place.

Step 2

Grasp the metal cover on each side.

Step 3

Gently pull the metal cover away from the backplane.

Step 4

Place the plastic cover against the shelf assembly and align the screw holes on the cover and the shelf
assembly (Figure 12-15).
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Attaching Plastic Lower Backplane Cover

78400

Figure 12-15

Step 5

Tighten the five retaining screws that hold the plastic cover in place.
Stop. You have completed this procedure.
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NTP-G135 Edit Network Element Defaults
Purpose

This procedure edits the factory-configured network element (NE) defaults
using the NE Defaults editor. The new defaults can be applied to the node
where they are edited or exported to a file and imported for use on other
nodes.

Tools/Equipment

None

Prerequisite Procedures None

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

For a list of network element defaults, see Appendix D, “Network Element Defaults.”

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to edit NE
defaults.

Step 2

Click the Provisioning > Defaults tabs.

Step 3

Under Defaults Selector, choose either a card (if editing card-level defaults) or NODE (if editing
node-level defaults). Clicking on the node name (at the top of the Defaults Selector column) lists all
available NE defaults (both node- and card-level) under Default Name.

Step 4

Locate a default you want to change under Default Name.

Step 5

Click in the Default Value column for the default property you are changing and either choose a value
from the drop-down menu (when available), or type in the desired new value.

Note
Step 6

If you click Reset before you click Apply, all values will return to their original settings.

Click Apply (click in the Default Name column to activate the Apply button if it is unavailable). You
can modify multiple default values before applying the changes.
A pencil icon will appear next to any default value that will be changed as a result of editing the defaults
file.

Step 7

If you are modifying node-level defaults, a dialog box appears telling you that defaults were
successufully applied to the node. Click OK.
If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will
reboot and asks if you want to continue. Click Yes.

Note

Changes to most node defaults reprovision the node when you click Apply. Changes made to
card settings using the Defaults Editor do not change the settings for cards that are already
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed
or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, see
Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder
cards see Chapter 5, “Provision Transponder and Muxponder Cards.”
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Note

Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for
the default to take effect. Before you change a default, view the Side Effects column of the
Defaults editor (right-click a column header and select Show Column > Side Effects) and be
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G136 Import Network Element Defaults
Purpose

This procedure imports the NE defaults using the NE Defaults editor. The
defaults can either be imported from the CTC software CD (factory
defaults) or from a customized file exported and saved from a node.

Tools/Equipment

None

Prerequisite Procedures None

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

For a list of network element defaults, see Appendix D, “Network Element Defaults.”

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to import NE
defaults.

Step 2

Click the Provisioning > Defaults tabs.

Step 3

Click Import.

Step 4

Click Browse and browse to the file you are importing if the correct file name and location of the desired
file do not appear in the Import Defaults from File dialog box.

Step 5

When the correct file name and location appear in the dialog box click OK. The correct file name is
15454-defaults.txt for ANSI shelves and 15454SDH-defaults.txt for ETSI shelves if you are importing
the factory defaults.
A pencil icon will appear next to any default value that will be changed as a result of importing the new
defaults file.

Step 6

Click Apply.

Step 7

If the imported file fails to pass all edits, the problem field shows the first encountered problem default
value that must be fixed. Change the problem default value and click Apply. Repeat until the imported
file passes all edits successfully.

Step 8

If you are modifying node-level defaults, a dialog box appears telling you that defaults were
successufully applied to the node. Click Yes.
If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will
reboot and asks if you want to continue. Click Yes.
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Note

Changes to most node defaults reprovision the node when you click Apply. Changes made to
card settings using the Defaults Editor do not change the settings for cards that are already
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed
or preprovisioned thereafter. To change settings for installed cards or pre-provisioned slots, see
Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder
cards see Chapter 5, “Provision Transponder and Muxponder Cards.”

Note

Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for
the default to take effect. Before you change a default, view the Side Effects column of the
Defaults editor (right-click a column header and select Show Column > Side Effects) and be
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G137 Export Network Element Defaults
Purpose

This procedure exports the NE defaults using the NE Defaults editor. The
exported defaults can be imported to other nodes.

Tools/Equipment

None

Prerequisite Procedures None
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Superuser

Note

The defaults currently displayed are exported whether or not they have been applied to the current node.

Note

The NE defaults can also be exported from the File > Export menu. These exported defaults are for
reference only and cannot be imported.

Note

For a list of network element defaults, see Appendix D, “Network Element Defaults.”

Step 1

Complete the “DLP-G46 Log into CTC” task on page 2-24 at the node where you want to export NE
defaults.

Step 2

Click the Provisioning > Defaults editor tabs.

Step 3

Click Export.

Step 4

Click Browse and browse to the location where you want to export the file if it does not appear in the
Export Defaults to File dialog box.

Step 5

Change the file name to something easy to remember (the file name has no extension).
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Step 6

Click OK.
Stop. You have completed this procedure.
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